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UNIT – 1 (QUESTION BANK) 

1 Explain history of Printing. 

2 What is Print? Explain. 

3 What are the types of printing? Explain. 

4 Explain Lithography. 

5 Explain offset printing. 

6 Explain about Printer.  

7 What are the types of printer? Explain. 

8 What are the types of Impact printer? 

9 What is thermal printer? 

 

UNIT – 1 (NOTES) 

1.1 INTRODUCTION TO PRINT MEDIUM 

What Is Print Media? 

Simply stated, print media is the printed version of telling the news, primarily 

through newspapers and magazines. Before the invention and widespread use of printing 

presses, printed materials had to be written by hand. It was a painstaking process that made 

mass distribution impossible. It was handwritten and posted in a public area much like 

today's posters or read from a scroll by a town crier. As early as 131 B.C., the ancient Roman 

government produced daily news sheets and informed the public in this way. Through the 

years, print media evolved to include entertainment, educational topics and more, instead 

of only conveying news. 

  

1.2 A BRIEF HISTORY OF PRINTING 

Around the year 932, Chinese printers adapted wood blocks, which had been used 

to print illustrations and small amounts of text, and started producing popular books more 

easily. Each page of text was one block that could be used repeatedly to make the books. 

About 100 years later, China's Bi Sheng invented movable type by carving individual 



International Institute of Technology and Management, Murthal 
BCA 2ND – Desktop Publishing (DP) – BCA 108-B 

 

2 
 

characters onto small blocks of clay. Each small block was hardened by fire to become a 

porcelain piece that could be used again and again. The pieces were glued to iron plates to 

make a page. Using each page hundreds or thousands of times, he could mass produce news 

quickly. When the printing was done, the pieces were removed from the plates to be used 

again to make other pages. 

 

Bi Sheng's invention had limited success in China because the Chinese alphabet's 

characters are so large that they were difficult to put on movable type. His idea spread all 

over the world, however, and others adapted it using other materials such as wood, tin and 

copper. Still, the process was too cumbersome to mass produce a newspaper for the public. 

 

Printing Press Mass Produces Newspapers 

In 1440, Johannes Gutenberg introduced his invention of a movable type printing 

press with type that was much easier to change, making the mass production of news pages 

possible. The invention spread throughout Europe, and printing and distributing sheets of 

news became popular. The World Association of Newspapers considers the first newspaper 

to be The Relation, which was published in Germany in 1604. It was published regularly 

(weekly), disseminated to the public and covered a range of news, from politics to 

entertainment. The Oxford Gazette was the first English paper to be published, starting in 

1665. It moved to London the next year and was renamed the London Gazette. It is still 

published today as the official publication of government news. 

Although the early American colonies published news sheets, the first true 

newspaper was published in Boston in 1690. Called Publick Occurrences Both Foreign and 

Domestick, it ran into trouble for publishing political criticism. Its publisher, Benjamin 

Harris, was arrested and all copies were destroyed. While the American colonies were 

adamant about freedom of religion, freedom of the press was another matter. The first 

successful newspaper in America was the Boston News-Letter in 1702. Its publisher, John 

Campbell, was careful not to publish any criticisms of the government. When Ben Franklin's 

brother was arrested in 1722 for publishing news critical of the government. 
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Too Pricey for the Public 

Ironically, the early mass-produced newspapers cost close to what most workers 

earned in a week, so only the wealthy could afford to buy them. Wealthy people were more 

likely to be literate at that time too. By the 1830s, though, publishers were able to print 

newspapers for about one cent per copy, making them truly available to the masses. By 

1900, newspapers were very popular because more people were literate and papers were 

affordable. They included the features we recognize today, including attention-grabbing 

headlines, news, society pages, sports, comics and the occasional use of spot color in special 

instances. 

 

 

Four Main Types of Printmaking 

It's been said that a picture is worth a thousand words. Writers may beg to differ, 

but it can't be denied that pictures grab attention and enhance the written word, whether 

in a book, in a newspaper or on a billboard. Images have been used along with words since 

the early days of printmaking. There are four ways to make prints from an original piece of 

art: relief, intaglio, lithography and screen printing. Choosing which type to use depends on 

the effect the artist and printer want to achieve. Relief printmaking uses wood, plastic or 

metal that the artist cuts into, cutting away the portions that won't be printed. When ink is 

applied to the surface, it highlights the raised areas, much like a rubber stamp does when 

pressed into a stamp pad. Woodcut has been used for centuries due to the availability of 

smooth hardwoods. Linocut is a more recent 20th century version of woodcut that uses 

linoleum. Wood engraving uses wood with no grain showing to achieve fine detail, and 

plastic is often used instead of the wood. 

Intaglio works in a nearly opposite way. Instead of creating raised areas, the artist 

etches grooves with an instrument or with acid. When ink is applied, it seeps into the 

grooves. The printing press pushes paper against the surface and ink in the grooved areas 

is printed. Different techniques can be used in intaglio to create soft lines, shading and 

detail. 

Lithography uses a flat piece of material, such as limestone or aluminium. The artist applies 

a greasy medium, like grease crayons, or a more liquid grease solution to the areas to be 
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printed. After treating the surface with a chemical solution, the ink adheres to the greased 

areas. Screen printing, also called serigraphy, uses silk or another fine mesh material which 

is stretched tightly on a frame. Areas that aren't to be printed are blocked off with paper, 

glue or specially made stencils. Ink is applied and pressed through the fabric with wood to 

which a rubber blade has been attached. (Think of a squeegee pressed against a surface to 

push water away.) The screen process is repeated for each color used, blocking out areas 

that aren't to be printed in that color. 

 

1.3 TYPES OF PRINTING 

Offset printing uses lithography to print on flat surfaces, like paper and plastic. When 

color is used, printing presses have a separate unit for each color and typically apply black 

ink first, followed by the colors one at a time. When mass quantities are needed such as 

when printing newspapers, a large roll of paper may be used instead of individual sheets. 

Flexology can be used to print on other materials, like cellophane and plastic labels, but is 

also sometimes used for newspapers. This process has a rubber plate that is inked and 

applied to the printing surface. Rotogravure is a longstanding process that uses a cylinder 

instead of a flat plate. The image is engraved onto this cylinder and ink is applied. It's been 

used for both newspaper and magazine printing but is often substituted today by offset 

printing and flexology, depending on the purpose. Digital printing using inkjet or laser 

printers has replaced many other printing processes because of the availability of accurate 

and affordable printers that can print on many different materials. 

 

Competition from Electronic Media 

Newspapers faced competition with the introduction of electronic media, which 

includes radio, television, CDs, DVDs and the internet. Radio and television are often called 

broadcast media because they are broadcast for all to hear, rather than reading print media. 

Radio transmissions began in the early 1900s but didn't take off until NBC began in 1926 

and CBS began in 1927. People were fascinated by the ability to hear the news instead of 

just reading it. Families gathered around their radio sets listening to the news of the day, 
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particularly during events such as elections, presidential speeches and news during World 

War II. 

Television was introduced at the 1939 World's Fair. It was merely a curiosity at this 

point, though, since its cost was roughly one-third of the average U.S. household's annual 

income. Technological advances resulting from World War II made television affordable for 

the masses in the 1950s. Advertisers jumped at the chance to reach housewives through 

soap operas, aptly named because the dramas were sponsored by soap manufacturers. 

By the 1960s, families gathered around their television sets as they had for radio decades 

earlier. Watching shows together became a nightly ritual. Television programming wasn't 

round-the-clock as it is today, but it started with a few programs at specific days and times. 

Cable channels expanded programming to all hours of the day. 

 

Computers Lead to the Internet 

By the 1980s, businesses sported desktop computers in their offices, and soon it became 

common to have one at home too. The World Wide Web was introduced to the public in 

1991. When Google introduced its search engine in 1998, people suddenly had a way to get 

vast amounts of information easily. Generations of people who grew up with internet 

availability at their fingertips began to get their news and conduct their research online 

instead of in print, and the internet became a clear competitor to print media as a way to 

spread news and information. Print media, such as newspapers and magazines, responded 

by hosting online websites in addition to their print version, and some even closed their 

print medium to become a wholly online medium. Others ceased production and closed 

their doors completely. 

The predicted demise of print media, however, hasn't happened. Many people use 

the internet but still like to hold a physical newspaper or magazine in their hands. It's 

familiar and reliable and not prone to glitches or outages. Physically turning the pages gives 

a feeling of satisfaction and control unmatched by any electronic medium. New print 

vehicles that cater to today's audiences continue to open. Many successful magazines have 

popped up as a result of popular TV programs, particularly food, home improvement and 

health shows. Instead of trying to compete with electronic media, successful print 

publishers look at what's popular in digital media and enhance it with print versions like 
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HGTV Magazine, Rachel Ray Every Day and Martha Stewart Living. Health publications like 

Prevention are still flourishing, as well as health niche publications like Shape and Runner's 

World. 

 

1.4 LETTERPRESS PRINTING 

Letterpress printing, also called Relief Printing, or Typographic Printing, in commercial 

printing, process by which many copies of an image are produced by repeated direct 

impression of an inked, raised surface against sheets or a continuous roll of paper. Letterpress 

is the oldest of the traditional printing techniques and remained the only important one from 

the time of Gutenberg, about 1450, until the development of lithography late in the 18th 

century and, especially, offset lithography early in the 20th. Originally the ink-bearing surface 

for printing a page of text was assembled from individual types by a typesetter or compositor, 

letter by letter and line by line. The first keyboard-actuated typesetting machines, 

the Linotype and the Monotype (qq.v.), were introduced in the 1890s. If only a small number 

of copies is to be made, printing can be done directly from the hand- or machine-set blocks 

of type assembled in forms, but for long press runs, duplicates—stereotypes 

or electrotyping (qq.v.)—are made to prevent wear and damage of the expensive types. 

Letterpress was originally carried out on platen presses, in which the paper is pressed against 

the flat, inked form by a flat platen; later, the platen was replaced by a roller in the flat-bed 

cylinder press; still later, the printing form was wrapped around one cylinder and the paper 

was passed between this cylinder and a second, creating a rotary press. 

 

Several procedures have been developed for the production of line drawings or 

reproduction of photographs in the form of halftone pictures by letterpress. The most widely 

used method of preparing a printing plate for such matter is photoengraving. Letterpress can 

produce work of high quality at high speed, but it requires much time to adjust the press for 

varying thicknesses of type, engravings, and plates. Because of the time needed to make 

letterpress plates and to prepare the press, many newspapers have changed to offset 

printing. To combat this trend, letterpress printers have developed printing plates made from 

a photosensitive plastic sheet that can be mounted on metal. 

 

https://www.britannica.com/technology/lithography
https://www.britannica.com/technology/offset-printing
https://www.britannica.com/technology/typesetting
https://www.britannica.com/technology/Linotype
https://www.britannica.com/technology/Monotype-typesetting-machine
https://www.britannica.com/technology/stereotype-printing
https://www.britannica.com/technology/electrotyping
https://www.britannica.com/technology/platen-press
https://www.britannica.com/technology/rotary-press
https://www.britannica.com/technology/photoengraving
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1.5 LITHOGRAPHY 

Lithography refers to a lithograph print that is made from an image which has been applied 

to a flat surface. It is a method of printing based on the principle that oil and water do not 

mix. Printing is done from a stone (lithographic limestone) or a metal plate with a grained 

surface; using oil-based inks. The artist works on a separate stone or plate for each colour. 

Traditionally this flat surface was a specially prepared limestone, but today grained aluminium 

printing plates and the original stones are used. An image is drawn, painted or 

photographically applied the stone or plate using a greasy medium. The image will repel water 

and accept ink. The inks are oil based and should be lightfast. The plate is placed on a special 

press and is then rolled up with either leather or rubber rollers. Paper is then placed on the 

print and is run through the press by hand. Like many other printing processes, one colour at 

a time is printed. Usually, one colour is printed per day. So a print that is built up of ten colours 

would take the master printer ten days to print. 

Lithography is a very versatile printing technique and artists can get the medium to 

suit the needs of their particular style. It can be subtle with many layers of washes or it can 

look like a pencil drawing with strong lines that pick up the texture of the drawing tool and 

the "tooth" of the plate. It can have large areas of flat colour or else areas can be "scratched" 

into. With a skilled master printer to guide the artist almost any effect is possible. The 

chemicals used in processing are relatively harmless and pose no threat to the artist.  

 

And offset lithography?  

Offset lithography, although evolving from the same chemical processes as hand done 

version, is a separate and distinctly different process. Offset printing is the technique used in 

industry for printing books, magazines etc. It needs complicated machinery and equipment 

and is only used by artists to do reproductions of their work.  When buying prints one should 

be aware that dealers and artists often refer to prints as original lithographs when they are in 

fact reproductions of artwork that are printed in the same way that posters and magazines 

are printed. These prints are not hand printed and they usually involve none or very little 

collaboration between the printer and the artist. They are often printed with inferior inks on 

inferior paper and will not have much of an investment value. When buying prints from 

someone you do not know well, it is always a good idea to ask for a copy of the documentation 
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sheet. The documentation sheet will provide you with all the information that you will need 

to assure you of the integrity of the print that you are investing in. If the artist or seller is 

unable to provide a documentation sheet then it is probably not worth buying the print. To 

see what information should be supplied by documentation sheet please refer to an example 

of a documentation sheet. 

 

1.6 OFFSET PRINTING 

Offset printing, also called offset lithography, or litho-offset, in commercial printing, 

widely used printing technique in which the inked image on a printing plate is printed on 

a rubber cylinder and then transferred (i.e., offset) to paper or other material. The rubber 

cylinder gives great flexibility, permitting printing on wood, cloth, metal, leather, and rough 

paper. An American printer, Ira W. Rubel, of Nutley, N.J., accidentally discovered the process 

in 1904 and soon built a press to exploit it. In offset printing the matter to be printed is neither 

raised above the surface of the printing plate (as in letterpress) nor sunk below it (as 

in intaglio, or gravure, printing). Instead, it is flush with the surface of the plate; thus offset is 

classified as a planographic method of printing. Offset printing, as a development 

of lithography (q.v.), is based on the principle that water and grease do not mix, so that a 

greasy ink can be deposited on grease-treated printing areas of the plate, while nonprinting 

areas, which hold water, reject the ink. The offset plate is usually of zinc or aluminum or a 

combination of metals, with the surface treated to render it porous and then coated with a 

photosensitive material. Exposure to an image hardens the coating on printing areas; the 

coating on nonprinting areas is washed away, leaving wetted metal that will reject ink. 

Modern offset printing is done on a press composed basically of three rotating cylinders: a 

plate cylinder, to which the metal plate is fastened; a blanket cylinder covered by a sheet of 

rubber; and an impression cylinder that presses the paper into contact with the blanket 

cylinder. The plate cylinder first comes in contact with a series of moistening rollers that 

deposit moisture in the granulations of the metal. A series of inking rollers then pass over the 

plate, and the ink is rejected by the water-holding areas and accepted by the greasy image. 

The inked image is transferred to the rubber blanket and is then offset to the paper travelling 

around the impression cylinder. 

 

https://www.artprintsa.com/documentation-sheet.html
https://www.artprintsa.com/documentation-sheet.html
https://www.britannica.com/science/rubber-chemical-compound
https://www.britannica.com/technology/cylinder-press
https://www.britannica.com/technology/paper
https://www.britannica.com/topic/intaglio-printing
https://www.britannica.com/technology/lithography
https://www.britannica.com/science/water
https://www.britannica.com/topic/ink-writing-medium
https://www.britannica.com/technology/printing-press
https://www.britannica.com/technology/plate-printing
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1.7 DIFFERENT PRINTING PROCESS 

 There are many different types of printing methods available and they're continuing to 

evolve. Each type is suited to a different need, meaning that businesses can choose a printing 

technique that best highlights their products or service. Printing is something that's been 

around since before 220AD. The oldest known printing technique is known as woodcut and 

involves carving an image onto a wooden surface. Printing has evolved a lot since then - 

instead of manual wood carving, you can choose from a wide range of technologically 

advanced methods. Here are seven of the most well-known and commonly used types: 

 

Offset Lithography 

Often used for: 

 Rough-surfaced media e.g. wood, canvas and cloth 

 Versatile method so can also be used for books, paper, stationery and more 

 

These plates are then transferred (offset) onto rollers or rubber blankets before going onto 

the print media, which can be any type of paper you want. The print media doesn't come into 

contact with the metal plates, which extends the life of the plates. As well as this, the flexible 

material of the rollers or rubber blankets means offset lithography can be used on any media 

with rough surfaces.  Offset lithography is great at producing consistently high quality images 

and can be used for small or high volume print jobs. It's also a versatile choice as it can print 

on any flat surface, regardless of whether it's smooth like paper or rough like canvas.  

 

Flexography 

Often used for: 

 Packaging and labels 

 Anything with continuous patterns e.g. wallpaper and gift wrap  

Flexographic printing is the modern version of letterpress printing and is commonly used for 

printing on uneven surfaces. This style of printing uses quick-drying, semi-liquid inks and can 

be used for high volume jobs. Flexible photopolymer printing plates wrapped around rotating 

cylinders on a web press are used. These inked plates have a slightly raised image of the 

content on them and are rotated at high speeds to transfer the image onto the print media. 

https://www.artsy.net/article/editorial-nine-types-of-printmaking-you-need-to
https://www.bbpress.co.uk/news/different-types-of-luxury-printing-paper-and-their-uses
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Digital Printing 

Often used for: 

 Posters and signage 

 Labels, newsletters, menus and letters 

 

Digital printing is a modern method that covers a variety of different techniques including 

inkjet printing and laser. In digital printing, images are sent directly to the printer using digital 

files such as PDFs. This eliminates the need for a printing plate, which is used in other types 

of printing such as lithography, and can save time and money (unless you're printing in larger 

numbers). Digital printing allows for quick turnaround and allows businesses to print on 

demand. It's also great for small run jobs - requests can be made for as little as one print. If 

you choose digital printing for the right job, it can make for a cost-effective method that still 

produces high quality prints similar to that of the other, bigger-scale options.  

 

Large Format 

Often used for: 

 Large signage e.g. billboards, posters, vinyl banners 

 Wallpaper and murals 

 Floor graphics 

 Laminating 

 

As the name might suggest, large format printing exists to produce maximum print roll width. 

Perfect for traditional advertising mediums and businesses who are looking to make a huge 

impact on their customers, this printing method gifts you with a much bigger area to work on, 

as opposed to the other methods such as digital printing. Rather than printing onto individual 

sheets, large format printing uses rolls of prints that are fed incrementally to produce one 

large sheet. For large print media such as building wraps, billboards, banners and murals, large 

format printing is the best option. The other printing methods will not be able to produce as 

large a material. Most businesses choose large format media to produce flat items which can 

be hung on a wall, but they can also be folded or made to stand freely.  
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Screen Printing 

Often used for: 

 Printing logos and graphics onto clothes 

 Fabric banners 

 Posters 

 

Screen printing is a printing technique where fine material or mesh is used to transfer an 

image onto another material. The mesh is stretched out so it creates a screen and ink is 

pressed against it in order to successfully print the image. Popularly used to print graphics 

onto clothes and other pieces of fabric, screen printing can also be used for paper and 

metal. There's a lot of setting up required with screen printing, so it's best used for printing 

repeat items in bulk. It's not very cost-effective for small number orders. But if you need a lot 

of the same image, it's a highly cost-effective method of printing.  

 

3D Printing 

Often used for: 

 Promotion and marketing freebies 

 Novelty items 

 Display items 

 Toy figurines 

Since the 1980s, 3D printing has allowed us to print three-dimensional objects, which can be 

a great way to make an impact on your audience. The desired objects of various shapes and 

sizes are created using digital model data from 3D models or electronic sources such as an 

Additive Manufacturing file (AMF). Additive compound mixtures are then fused together to 

produce this 3D object.  3D printers have continued to get more and more sophisticated. 

Today, even items with interior moving parts can be printed. After the details have been 

worked out on a computer programme such as CAD, miniscule layers are printed on top of 

each other using a special plastic substance.  

 

LED UV 

Often used for: 
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 Newsletters, posters and leaflets 

 Magazines, catalogues, brochures and prospectuses 

 Stationery 

 

LED UV printing is a method that's becoming increasingly popular among businesses due to 

its extremely high quality prints and quick turnaround times. It's a form of digital printing that 

uses UV (ultraviolet) lights to dry the ink as it's being printed. The drying process, also known 

as UV curing, is unique and sets it apart from the other printing methods because it's 

instantaneous and prevents the ink from sinking into the materials. The results? You no longer 

have to wait for the ink to dry, which saves time and the colours come out looking much 

sharper and clearer. LED UV is eco-friendly as it uses less power than traditional print 

machines and unlike many of the other methods, it's not limited to the type of stock (printing 

materials) or to certain print jobs. Its versatility means it's ideal for a wide range of projects 

including brochures, catalogues, prospectuses and posters. Because of its ability to instantly 

dry ink and produce bright, vivid colours, it can turn an ordinary product into a luxury, high 

quality product that is attention grabbing. 

 

 

 

 

 

 

 

 

 

 

 

https://www.bbpress.co.uk/news/is-led-uv-printing-the-future
https://www.bbpress.co.uk/news/what-is-uv-curing-and-how-is-it-used-in-printing
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UNIT – 2 (QUESTION BANK) 

10 Explain Visual Communication in Detail. 

11 Explain elements of Visual Communication: 

(a) Line 
(b) Shape 
(c) Texture 
(d) Text 
(e) Color 

12 What are the types of shape? 

13 What do you understand by Texture? 

14 What are the types of texture? Explain. 

15 Explain the principles of Visual communication. 

 

 

UNIT – 2 (NOTES) 

ELEMENTS AND PRINCIPLES OF DESIGN AND VISUAL COMMUNICATION  

 

2.1 DESIGN ELEMENTS AND PRINCIPLES 

In the game of soccer there are many components. But if players just go out onto the 

field and simply act out moves; kick, run, pass, throw in, cross the game will be a mess. What 

we need is a coach to coordinate the players' moves. We need some strategies. We need to 

know when to attack and when to defend. In this way the individual components of the game 

can be seen as the design elements and the strategies the design principles. When you Google 

design elements and principles you will find more than are on this list. There are many more. 

Likewise, if you do other VCE arts subjects like Art, Studio Arts or Product Design you will find 

different groups again. All of the elements and principles listed in books and other studies are 

right and all are valid. However, VCAA have created this group for Visual Communication 

Design. The identification and discussion of design elements and principles comes naturally 

in the analysis of communication design but with practise, you will find that they can be 
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applied equally as well to analyses of environmental and industrial design. Students must 

realise that they may be examined in their application of these concepts within all design 

fields. 

 

On Using Design Elements and Principles in Production Exercises 

Students may be asked to demonstrate their understanding of design elements and 

principles by drawing a given shape or letter into a new composition. Other tasks ask students 

to design a visual communication using a set of criteria including design elements and 

principles. Students should be mindful that in demonstrating their understanding of design 

elements and principles in practical examples, they need to emphasis the selected element 

or principle. As far as possible they should ensure that their selection of element or principle 

is clearly focused on that element or principle. For example 'shape' should be shown as a solid 

figure, without the use of 'line'.  

 

ON CHOOSING THE BEST DESIGN ELEMENTS AND PRINCIPLES FOR ANALYSIS  

In written tasks requiring the analysis of design elements and principles, students 

should be aware that only elements and principles that clearly suit the example should be 

chosen for analysis. Time spent on careful selection of the best, most emphasized elements 

and principles is time spent well. Students then concentrate their discussion solely on the 

element or principle being analysed. When discussing the role of design elements and 

principles in design the use of a correct verb is important. Students should note that an 

element is usually 'used' to 'create' an effect and a principle is often 'created' by the 

manipulation of an element. For example: Different kinds of shapes (element) have been used 

to create contrast (principle).  

 

MODEL ANALYSIS 

Beneath each design element and principle you will find an example of analysis demonstrating 

how the language shown can be used to identify and describe the aesthetics and function it 

plays in a visual communication. 
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 Design elements are the components of visual communication: 

COLOUR 

 

DESCRIPTION 

Colour is different kinds of light visible to the eye. It is understood using two different 

models. Additive colour is created by three different lights in screens (RGB) adding together 

to create white. Subtractive colour is created by three + black (CMYK) inks or paints 

subtracting reflected light on paper to create black.  Colour 

communicates optically and emotionally. We discuss colour in terms of colours relative to 

other colours and in terms of how it makes us feel. 

 

IDENTIFY 

The groups combinations of colours belong to including; primary, secondary, warm and cool 

colours, harmonious, complimentary colours.  Do not confuse the discussion of 'tone' here. 

Do not identify colours as light or dark when you mean warm and cool. (They may indeed, be 

light and dark, but this is a discussion of tone). The function of colour; to decorate, 

emphasises or categorise. 

 

MODEL ANALYSIS 

Colour has been used to create depth in the portrait. Yellow has been used on the areas of 

the face closest to the viewer and blues have been used in the background. This enhances the 

effect of form in the picture. 
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SHAPE 

 

DESCRIPTION 

Shape is a two dimensional enclosure. It can be made with lines or with a 'fill'. (Colour, shape 

or texture). A shape in VCD is usually filled. When asked to produce shape students should fill 

their shape to demonstrate their understanding of the difference between shape and line.  

Shape is a common component in logos and type. Shapes 

communicate optically and emotionally. 

 

IDENTIFY 

The name of shape. (Circle, square, abstract). 

The kind of shape. Shapes exist in two main categories - organic and geometric. Organic = 

natural, random or flowing. Geometric = 'man made' or mathematical like a square, triangle 

or circle. The edge of the shape and it is hard edged or soft and blurred? The function of shape 

and is used to organise space, create an effect or as a symbol to assist with recognition. 

 

MODEL ANALYSIS 

A simple, rectilinear, geometric shape was chosen for the screen of an iPad. The corners are 

slightly rounded to lead our eyes move smoothly around the plane. The shape is repeated, at 

a bigger scale for the frame around the screen. The use of rectangles with rounded corners 

creates consistent brand recognition between all of the products in Apple's devices. 
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LINE 

 

DESCRIPTION 

Line is a continuous mark on a surface. There are many useful adjectives that can be used to 

describe line. Line can be used to; 

 emphasise something (an outline on a character, underline), 

 to divide components in a composition (column line), 

 to create a figure (lines in an observational sketch), 

 to create tone and texture (cross hatching, shading), 

 to create form (lines on an angle), 

 To organise space (visible or hidden grid lines in a webpage). 

IDENTIFY 

The purpose of the line. Ask what is the line being used to do? The kind of line. 

Use adjectives to precisely describe the kind of line that has been used.  Describe the kind 

of media that has been used to make the line. The characteristics of the line will vary between 

those made by computer, pen, pencil, brush, etc.  Describe the method of making the line. 

Both the media and the method used influence the character of line and are used 

to communicate specific intentions of the designer.  

 

DISCUSS 

Line can be geometric, or organic. Line can be ruled or freehand. Thick or thin. Straight or 

curved, solid, dotted, dashed, sensitive or flowing.  Line can be visible or implied. (As in a 

grid layout).  The use of line can follow conventions for technical drawing (line work for 3rd 

Angle Orthogonal or Plans and Elevations). The characteristics of the line reflect 

the purpose of the visual communication.  
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MODEL ANALYSIS 

The sketch of the old building was made freehand with a dip-pen. The drawing is made from 

organic lines of uneven strength and length. This haphazard and random approach to building 

up the drawing both with the hesitant outlines and grey cross-hatched shadows captured the 

decaying nature of the old building.  

TONE 

 

DESCRIPTION 

Tone is a variation of intensity of colour. Tone is described with adjectives such 

as light and dark. The discussion of tone can include value, percentage, tint or shade.  Tone 

refers to variation in range in a monochromatic field and can apply to any colour except 

white.  

Tone can be used to create or emphasise form with linear or radial gradients. These terms 

are usually connected with digital artwork. 

 

IDENTIFY 

The purpose of the tone is to create or emphasise form. When we shade a drawing to make 

it look three dimensional we are using tone. How tone emphasises the direction and intensity 

of a light source.  

 

MODEL ANALYSIS 

A gentle, soft tone was used across the picture of the baby sleeping. Although the darker 

shades of grey were still quite light, there was a consistent variation between the highlights 

on the baby's forehead and the shadow underneath her chin. This consistent yet gradual 
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shading across the head implied a soft light coming from the window above and to the right 

of her head. 

TEXTURE 

 

DESCRIPTION 

Texture refers to the surface of an object or an image. Texture can be actual or implied.  

Actual texture can be felt with our hands (checker-plate aluminium, rough oil paint), 

and implied texture looks like real texture, although it might be printed on gloss paper. 

Texture can be made from raised or lowered sections of a surface (relief, embossing, etching) 

or with pen, pencil, or points (cross hatching, dot rendering). 

 

IDENTIFY 

The kind of texture - actual or implied. What the purpose of the texture. Is it for function or 

visual appeal? How the texture has been made - materials, methods and/ or media. The 

presence of texture in visual communication is often associated with a more human or 

friendly feel to an image. Similarly a lack of texture creates a corporate, professional feel.  

 

MODEL ANALYSIS 

The cardboard beer package was printed with an old fashioned woodgrain texture like what 

would be seen on an old fence. This made it seem like an old packing case that might have 

been used to carry bottles in the past. This rustic effect very much suited the character of the 

strong craft beer. 
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FORM 

 

DESCRIPTION 

Form is a three dimensional entity. It is often made from shapes, lines or even colours. Form 

creates space and depth. The discussion of form includes actual form as it relates to objects 

in each design field, particularly industrial and environmental design. Form can also be 

created on a two dimensional space as in an illustration or photograph.  

IDENTIFY 

The names of forms. (Cube, sphere, tetrahedron, etc.) The kind of form using similar language 

as 'shape'. (Geometric, biomorphic, abstract). The purpose of the form and/ or the 

relationships with other design elements.  

 

DISCUSS 

Use adjectives as used for 'shape'.  Additional adjectives include; solid, slender, cylindrical, 

rectangular, conical. The ways forms have been constructed and the materials that may have 

been used and the reasons for their use. 

 

MODEL ANALYSIS 

The chair was made from two contrasting kinds of forms. The body of the chair was a beautiful 

soft biomorphic form reminiscent of a bent jelly bean. The designer contrasted the bulk of 

this form with four slender legs looking like those found on insects. A plastic sheet material 

like vinyl was chosen for the surface of the body of the chair as it would stretch to cover the 

foam that made the form, and a chrome steel was chosen for the legs as it was able to be 

bent into shape and was strong enough to retain its shape when supporting a person. 
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POINT 

 

DESCRIPTION 

A point is the smallest mark in a visual communication. It is usually a dot or circle in 

shape. Point can be used to create tone or texture in a rendering. Points can be strung 

together to create line. Point can be used to emphasis information. 

 

IDENTIFY 

The purpose of the point. 

The shape of the point. 

The visual characteristics of the point (methods or media). 

 

DISCUSS 

The visual characteristics of the point using similar adjectives for shape or line. The placement 

of the point, the colour of the point.  

 

MODEL ANALYSIS 

Large red dots are used on the map to show the intersection of train-lines that include a 

physical interchange for passengers. The size and colour of the point is such that it contrasts 

with the grey background to maintain clarity. 
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TYPE 

 

DESCRIPTION 

Type is writing in visual communications. It is a special design element in that it communicates 

through the meaning of words and through the aesthetics of the type forms themselves. 

Type has a long history and through associations with various uses, methods of 

manufacture including wood and metal blocks, digital and hand generation and 

the locations from which type forms come. Type forms themselves are embedded with 

meaning. Type is classified into certain groups for communication, use and analysis. Type 

forms can be broken into anatomical parts. The construction of these parts forms the 

discussion of type forms. Designers who use type (typographers) make many stylistic and 

functional adjustments to the way the type appears on the visual communication.  

 

IDENTIFY 

The whole examination of type rests on our ability to determine how a chosen type form 

communicates ideas to an audience. One has to identify the precise characteristics of a type 

form as distinct from another. The classification of type forms. (Serif, Sans serif, display, 

decorative). The associations these classifications have in relation to the meanings of the 

words they are forming. (Contemporary, objective, authoritative, judgemental, European, 

American, retro, futuristic, military, digital, 3d, etc). The position a type resides in a type 

family is considered. Is it light, roman, bold, heavy or black, condensed, regular or extended? 

 

The function and use of the type form. (Headline, subheading, body copy). The method used 

to form the type. The aesthetic quality and anatomy of the type form. (Ratio of stroke weights 

to each other, proportions of anatomical parts - ascenders, x-height, etc.) 
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The adjustments that have been made to the arranging of type - known as typesetting. (Case, 

alignment, colour, size, leading, tracking, kerning, etc). 

 

DISCUSS 

The functional and aesthetic qualities of type forms. Look for the ways type forms and type 

setting conventions and processes are used to engage audiences. How have shape, colour, 

weight been used to attract a particular age, gender or cultural group? A knowledge of all of 

the aspects of type shown here is essential for a detailed analysis of type. 

MODEL ANALYSIS 

They flyer uses a large heading for the name of the film 'The Hurt Locker'. In the upper half of 

the format are three lines of a modern, bold, sans serif capitalised type in a face like Helvetica 

Black. The type is force justified bringing the ends of each line to fill the space and is tightly 

tracked with very tight leading to make it appear as a block. Like an  impenetrable wall. The 

almost solid positive form of the type, set against a black background is ideal for the technique 

of making it transparent revealing action from the film through the letters. Beneath this super 

strong title are several rows of reversed out (white) extremely condensed capitals in a light 

version of the same font. This light type counter balances the weight of the title.   

 

BALANCE DISCRIPTION OF DESIGN PRINCIPLES 

Balance in visual communication refers to the arrangement of components on two sides of a 

seen or implied vertical axis. There are two ways to balance a composition. 

Symmetrical balance is where the two sides of the composition are exactly the same (or very 

nearly the same) and they make a mirror image of each other. Symmetrical balance creates 

a static, stable composition and is suited to informative or instructional visual 

communications. Asymmetrical balance is where the two sides of a composition are 

balanced, yet are not mirrored. In order to achieve balance off centre different sized 

components are given more or less visual weight. Visual weight is increased of decreased by 

changing on or more of; tone, colour, size or proximity to the central axis. Visual 

communications employing asymmetrical balance create a more dynamic composition and 

are suited to purposes where audiences are encouraged to interact with the design. Balance 

in communication design may also refer to components set either side of the horizontal axis. 
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This will involve the broader study of composition and includes grid layout, random layout, 

radial balance, spiral balance, triangular composition. Balance in industrial and environmental 

design will involve the physical balance of a structure. 

  

IDENTIFY 

The kind of balance used in the visual communication. State if it is symmetrical balance or 

asymmetrical balance. Identify the parts on each side that make up the composition and state 

how they create the balance you have identified. 

 

DISCUSSION 

When describing balance, one is required to explain how the balance has been created. This 

usually involves discussion of relevant design elements. The kind of balance present in the 

visual communication is related to its purpose. The analysis explains how the balance, 

identified and explained contributes to the communication of ideas to that end. 

 

MODEL ANALYSIS 

The icon for symmetrical balance (at left) uses symmetrical balance. If one was to draw a 

vertical line down the centre of the circular field one would see that both halves of the 'A' are 

the same. Therefore, it is a mirrored symmetrical composition. However, the icon for 

asymmetrical balance (also left) uses asymmetrical balance. The two sides, on a vertical axis 

are not the same. Filling most of the right half is a large 'A' shape coloured in a mid-green 

contrasting sufficiently with the yellow ground to read. This is balanced by a small dark blue 

square sitting to the far left of the composition. Although the square is much smaller than the 

letter, it has an increased visual weight through it being both further from the centre and in 

a much darker tone than the 'A'. 

Proportion refers to the ratio of the dimensions of a component. Two components 

may be similar in shape, however the length and height of each are different. They are said 

to be of different proportions. One needs to be careful not to confuse proportion with scale. 

Proportion is not overall size, it refers to the ratio of height, width and/ or depth to each 

other. Different (presentation) formats also are of different proportions. They have different 

heights and widths. Some easy to relate to formats are; 
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 Landscape, 

 portrait,  

 Square, 

 Wide screen (16x9) 

 TV (4x3) 

 

A similar design will have to be adjusted to suit each of the above formats as they have 

different proportions. Proportion may also refer to how much of a kind of content. Think 

about the proportion of image to text on this page compared with the proportions of image 

to text on my artwork page.  

 

IDENTIFY 

The relative height, width, length, depth of two or more components of a visual 

communication. Identify the format used in the visual communication. Compare it with others 

if required. 

 

DISCUSS  

Proportions of components referring to their heights, widths, etc. relative to each other. You 

may use adjectives such as tall, thin, squat, wide, condensed, extended. How the size, quantity 

of the components of a visual communication have been modified to suit formats of different 

proportions. The proportion of types of content to each other and this may relate to the 

discussion of balance and hierarchy. 

 

MODEL ANALYSIS 

In the icon (at left) there are two capital 'A's. They are from the same type face. However, the 

proportions have been adjusted so that the left 'A' is tall and thin and the right, short and fat. 

The two characters are of different proportions. 

  

HARMONY AND PATTERN 

DISCRIPTION 
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The  term pattern refers to the repetition of one or more visual unit (shape, image, etc). In 

our study there are two kinds of pattern. Repetition, where the same kind of visual unit 

repeats and alternation, where different units repeat in a rhythm. Pattern can 

create shade,  texture or decorate. Patterns usually have historical and cultural origins and 

are a fantastic way to embed intercultural understanding into our course. Pattern making has 

been a meaningful and cathartic human undertaking for centuries. 

  

IDENTIFY 

If the pattern in repetition or alternation. The kinds of visual components that make up the 

pattern using design elements and/ or principles.  

The rhythm and/or density of the pattern units to the ground.  

The historical, national, cultural heratige of the pattern if any. 

  

DISCUSS 

The purpose, use or function of a pattern. The exact make up of the pattern using design 

elements and/ or principles. The kind of rhythm the pattern is producing. The overall aesthetic 

effect of the pattern. 

 

MODEL ANALYSIS 

'Tartan' cloth is a pattern made from woven thread. It is an alternating pattern formed by 

parallel horizontal and perpendicular lines of light and dark coloured thread that seem to 

overlap and create layers above and below each other. In addition other parallel lines with a 

much wider rhythm create squares of the base colour which form a kind of background. 

Tartan has a rich history as families from different regions in Scotland were known by their 

unique tartan design. 

  

EMERGENCE OF GRAPHIC DESIGN AND VISUAL COMMUNICATION 

There are many different definitions for it. Primarily associated with two-dimensional 

images, it includes: art, signs, photography, typography, drawing, graphic design, illustration, 

color and electronic resources. Recent research in the field has focused on web design and 

graphic oriented usability. Graphic designers use methods of visual communication in their 
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professional practice. Visual Communication expresses emotion, feelings, ideas, information 

and thoughts with a combination of words and pictures, art, typography, photography, 

symbols, movies and/ or sounds. I believe that the term communication needs to be extended 

a little bit further. Nonverbal communication goes far beyond body gestures and writing. 

Communication is also expressed through pictures, images and symbols and the combination 

of all these. The result is called Visual Communication. 

 

The History 

The history of visual communication dates back to a time where writing was not yet 

invented. It dates back to a time where history was persevered in paintings found on rocks 

and in caves dating back more than 40.000 years ago. Fast forwarding to usage 

of ideograms up to the invention of the alphabet. It is safe to say that visual communication 

has always been a part of our existence. The invention of the alphabet was a beautiful time, 

because books were being published and beautiful illuminated scriptures were presented as 

a piece of art. We can fast forward a bit more in time and we would reach the avant-garde, 

modernist and finally the computer era. Visual communication had changed drastically in the 

era of avant-garde, modernism and postmodernism. In the beginning before most people 

were able to read or write, every part of life was based on God. God was the center of all 

things and people were very faithful and loyal to their religion. In the modernism era, people 

became more concern with them and were placing humans being above God and it was all 

about improving and the reshaping the environment. In the Postmodernism era, people lost 

the sense of morality completely. There were no more clear division between right or wrong, 

evil or good, no truth at all. We life in a era where TV Idols such a Oprah promotes humans as 

Gods. The people behind the visuals install ideas of right or wrong within the heads of the 

masses. I believe that visual communication will never die, it will only get more powerful in 

the sense of having the power of placing ideas, morals and believe within someone’s mind so 

tactically that the person would become convinced that it was his/her original idea to begin 

with. It is a powerful tool that can be used for either good or wrong, and judging from the era 

we are living in right now the line between right or wrong is pretty much blurred out. 
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UNIT – 3 (QUESTION BANK) 

16 Explain Adobe Photoshop. 

17 What is Photoshop? 

18 Explain the basic terms related to an image. 

19 What is bitmap image? 

20 What is vector image? 

21 What are the steps to create a new document in Photoshop? 

22 What is Menu bar in Photoshop? 

23 What are the tools in Photoshop? Explain 

24 What are step to crop an image? 

25 Explain working with shape process. 

26 Explain the layers in Photoshop. 

27 Explain the layers panel. 

28 How to create a new layer? Explain. 

29 Explain linking and unlinking layers. 

30 What is color modes in Photoshop? 

31 What are the different types of Color modes in Photoshop? 

32 What is HSB Color mode? Explain. 

33 Explain Channel panel in Photoshop. 

34 Explain filters. 

 

UNIT – 3 (NOTES) 

3.1 INTRODUCTION OF COMPUTER GRAPHICS 

Computer Graphics involves technology to access. The Process transforms and presents 

information in a visual form. In today life, computer graphics has now become a common 

element in user interfaces, T.V. commercial motion pictures. Computer Graphics is the 
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creation of pictures with the help of a computer. The end product of the computer graphics 

is a picture it may be a business graph, drawing, and engineering. In computer graphics, two 

or three-dimensional pictures can be created that are used for research. Many hardware 

devices algorithm has been developing for improving the speed of picture generation with 

the passes of time. It includes the creation storage of models and image of objects. These 

models for various fields like engineering, mathematical and so on. Today, computer graphics 

is entirely different from the earlier one. It is not possible. It is an interactive user can control 

the structure of an object of various input devices. 

 

Definition of Computer Graphics: 

It is the use of computers to create and manipulate pictures on a display device. It comprises 

of software techniques to create, store, modify, represents pictures. 

 

Why computer graphics used? 

Suppose a shoe manufacturing company want to show the sale of shoes for five years. For 

this vast amount of information is to store. So a lot of time and memory will be needed. This 

method will be tough to understand by a common man. In this situation graphics is a better 

alternative. Graphics tools are charts and graphs. Using graphs, data can be represented in 

pictorial form. A picture can be understood easily just with a single look. Interactive computer 

graphics work using the concept of two-way communication between computer users. The 

computer will receive signals from the input device, and the picture is modified accordingly. 

Picture will be changed quickly when we apply command. 
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3.2 VECTOR GRAPHICS 

Vector graphics is the creation of digital images through a sequence of commands or 

mathematical statements that place lines and shapes in a given two-dimensional or three-

dimensional space. In physics, a vector is a representation of both a quantity and a direction 

at the same time. In vector graphics, the file that results from a graphic artist's work is created 

and saved as a sequence of vector statements. For example, instead of containing a bit in the 

file for each bit of a line drawing, a vector graphic file describes a series of points to be 

connected. One result is a much smaller file. At some point, a vector image is converted into 

a raster graphics image, which maps bits directly to a display space (and is sometimes called 

a bitmap). The vector image can be converted to a raster image file prior to its display so that 

it can be ported between systems. 

A vector file is sometimes called a geometric file. Most images created with tools such 

as Adobe Illustrator and CorelDraw are in the form of vector image files. Vector image files 

are easier to modify than raster image files (which can, however, sometimes be reconverted 

to vector files for further refinement). Animation images are also usually created as vector 

files. For example, Shockwave's Flash product lets you create 2-D and 3-D animations that are 

sent to a requestor as a vector file and then rasterized "on the fly" as they arrive. 

 

3.3 BITMAP  

A bitmap describes a type of image that web-users encounter all the time without realizing it. 

Basically, it’s a grid where each individual square is a pixel that contains color information. 

The key characteristics are the number of pixels (or squares in the grid), and the amount of 

information in each grid square (pixel). 

If you’ve already been reading up on your design vocabulary, you might be thinking that this 

sounds… familiar. Is it déjà vu? Not quite. Bitmaps and raster images are interchangeable 

terms that refer to the same concept: a grid full of pixels that—when arranged densely 

enough—form a clear image. 

https://whatis.techtarget.com/definition/raster-graphics
https://whatis.techtarget.com/definition/Flash
https://www.figma.com/dictionary/raster-graphics/
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What You Need to Know About Bitmaps 

Like raster graphics, bitmaps are made up of individual, tiny points that blend together to 

form a unified image. Unlike vector graphics, which are infinitely scalable, you can’t stretch 

or enlarge them without compromising the quality. 

 

1. How It’s Created and Stored 

When you break down an image into a grid made of thousands of squares, you get a bitmap. 

Each square in that grid holds a little bit of color data and displays (or doesn’t display) a color 

based on that data. Like a color-by-numbers sheet, a key correlates each point’s data 

assignment with a color. In the end, it provides the literal map that tells you what that image 

should look like once it’s put together. 

 

2. Bitmap Graphics vs. Raster Graphics 

 

Raster graphics and bitmaps are closely related. Though they’re not exactly the same thing, 

the two phrases are often used interchangeably. If you’re curious about the subtleties: * A 

bitmap refers to a specific type of data storage—a map of bits. * A pix-map is, similarly, map 

of pixels.* A raster image can be either of the above, depending on how complicated the 

encoded data is. 

 

3. Bitmap File Formats 

There are several file formats to choose from, and each has advantages and disadvantages. 

You’ve likely heard of (or used) some of these file types—BMP, GIF, JPEG, EXIF, PNG, and TIFF. 

You can determine a file’s format by where it came from or how the image will be used. 

https://www.figma.com/dictionary/bitmap/#what-you-need-to-know-about-bitmaps
https://www.figma.com/dictionary/#vector
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Windows exclusively uses BMPs; GIFs and JPEGs are designed for web transfer; and EXIF files 

come from digital cameras and carry photo-specific information and camera settings. BMPs 

are large, full files that can’t be compressed. Other formats, like GIF, JPEG, and PNG use 

compression algorithms that make the files smaller and easier to upload and download via 

the internet, making them extra convenient when working with online projects or designs. 

 

4. Problems with Bitmaps 

First, remember that the size of the file correlates directly with its quality. The higher the 

quality, the bigger the file—which can be tough if you want to use a high-quality image on the 

web (and you probably do!). Second, keep in mind that a bitmap graphic can become pixelated. 

Pixelation happens when you stretch an image until the pixels become visible, making it blurry 

or blocky. But if you’re aware of these problems and take them into consideration during your 

project, you can work with bitmaps without too much hassle. 

 

3.4 UNDERSTANDING IMAGE RESOLUTION AND SIZE 

Understanding image resolution 

Image resolution is measured by the number of pixels per inch that shows up on a digital 

screen. You have probably also heard of the term dots per inch or DPI, but more about that 

later as it can be quite confusing. The more pixels you have on your screen, the higher the 

image resolution.  

For web, pixels per inch do not matter as the sizes of devices, or your computer 

monitor is already set. Unless someone is going to take the image from the website and print 

it, an image with 72 pixels per inch displays the same as a 300 pixels per inch photo on all 

devices. This is where understanding image resolution for printing becomes more important. 

  

Pixels per inch and printing 

Pixels per inch are important when printing images. The more pixels you have per inch, the 

better the image resolution. This means that you will get better quality prints. Generally 240 

or 300 pixels per inch are acceptable for printing. When it comes to large scale printing such 

as billboards, it can be larger than 300. The height and width of an image is also important to 

determine image resolution as PPI is only a relative measure. 
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Understanding image resolution and size 

  

 

Image size of smaller image 

 

 However, when the image was saved in a smaller format – below is how this changed the 

dimensions of the photo. 

  

https://blog.slickpic.com/blog/wp-content/uploads/2017/06/resolution-Original-photo.jpg
https://blog.slickpic.com/blog/wp-content/uploads/2017/06/resolution-image-size-of-smaller-image.jpg
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Image size of original 

  

Now, you are probably asking how that makes a difference. The resolution of the small image 

have decreased so much, just look at the effect on the female walking in front when zoomed 

in. The pixels per inch have decreased so much that her hair alone is far less than 50 pixels. 

 

Small resolution affects pixels per inch 

  

But compare this to the original image – zoomed in. It becomes impossible to count the pixels 

in her hair alone. 

  

https://blog.slickpic.com/blog/wp-content/uploads/2017/06/resolution-image-size-of-original.jpg
https://blog.slickpic.com/blog/wp-content/uploads/2017/06/resolution-small-resolution-affects-pixels-per-inch.jpg
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Large resolution pixels per inch 

 

What about image size? 

Once you understand image size better as illustrated above, you will realise that size do 

matter. Larger images can be printed larger without pixelating as there are much more pixels 

per inch while the same is not true with smaller photos. Understand now why photos 

pixelate? You are that much closer to understanding image resolution. Today, we have the 

ability to shoot at any resolution and quality setting we want. But this comes at a price. With 

smaller sizes you sacrifice print quality, but bigger quality settings influence storage space. 

However, I will say that with the affordability of storage solutions these days, the birth of 

cloud storage and photo sharing and storing sites like SlickPic, there is really no excuse for not 

shooting at maximum quality. You can always make the image smaller if you want to use it 

online later. 

 

3.5 RELATION BETWEEN SIZE, RESOLUTION 

Pixels have no set size, they just expand or contract to fill the space available. Below the same 

image is shown twice, both times at the same image or document size. But each copy is made 

up of a different number of pixels which just expand in size to fit the image size. So while both 

'image sizes' may be the same, the resolution of each is clearly different. 

https://www.slickpic.com/
https://www.slickpic.com/?t=blog-resolution
https://blog.slickpic.com/blog/wp-content/uploads/2017/06/resolution-large-resolution-pixels-per-inch.jpg
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FIGURE 1 This image is made up of 1200 x 800 pixels and looks to the eye like a scene might 

look in reality 

 

The aim is to have enough pixels, which when resized to fit the image size, are smaller than 

the monitor or printer dots. The image above has a pixel size smaller than the monitor dots 

and so looks good. The picture below has too few pixels and so have resized to the point 

where the pixels are larger than the monitor dots and the image looks either bad, or even 

useless as in the 12 x 8 pixels image. 

 

FIGURE 2 Although blown up to the same size as the previous image, this image is made up 

of only 120 x 80 pixels and now we are starting to see the actual pixels, which is called 

'pixelation.' 

 

Below are the same images as before but resized so that the pixel resolution is 72  dpi to suit 

the monitor. Since the pixels are now set to the same resolution, it is the image, or document 

size, that shrinks or expands to fit. Both images now have the same resolution; it is now the 

image size of each that is clearly different. 
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FIGURE 3 Here the same two images are now set to the same resolution. While both look 

good now, what differs is the size at which the image is displayed. The smaller image only has 

enough pixels to display well at that size.  

 

This means that when talking about the working file size of an image it is not enough to just 

state the resolution or image size by itself. Both resolution and image size need to be used 

together. 

 

Resolution 

So, often people speak about a 300 dpi image as being a quality image. But what do they 

mean by a '300 dpi' image? This is rather like someone asking you how far is it from Abuja to 

Lagos and you answer '70 kilometers per hour'. They would look at you funny. That is because 

you only told them half of the answer. Yes it may be 70 kilometers per hour, but you need to 

tell them for how many hours. This is the same as someone saying, 'Oh, just give me a 300 dpi 

image'. What they have told you is that they want each inch of your image to have 300 dots, 

but they haven't told you how many inches they want the image to be. It is the number of 

pixels in an image that determine file size; resolution by itself is not enough. 
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FIGURE 4 This is one inch of the image below. DPI means 'dots per inch' but you need to 

know how many inches to know the file size of an image. Just giving the resolution is not good 

enough. 

 

FIGURE 5 Above is the full image. The image is clearly more than just one inch square. So to 

understand the file size you need to know both the resolution (300 dpi) and the reproduction 

size (8 inches high by 12 inches wide, for example). So when an editor or a designer is asking 

you for an image and they say, "Just send me a 300 dpi image", you need to ask, "300 dpi at 

what dimensions?" 

 

File Size 

There is actually an easier way to ask the editor what he really wants and that has to do with 

file size. This is much the same way that if someone asked you the distance between Abuja 

and Lagos it would be easier to answer, '700 kilometers'. 
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FIGURE 6 An A4 grayscale image at 300 dpi is calculated below at 8.6 MB in size. In reality it 

is closer to 8.7 MB simply because the dimensions of an A4 page are larger than 8 x 12 inches. 

 

To see how the file size is calculated, take the image above as an example and assume that it 

is A4 at 300 dpi. To simplify it let's assume that is 8 inches x 12 inches.  

 

File size is determined by the number of pixels so the aim is to find out how many pixels the 

image contains. Since the resolution is 300 dpi, it means that each inch is 300 pixels across. 

As the image is 8 inches wide that means there are 2,400 pixels in width (8 x 300). Likewise, 

as the image is 12 inches long, the image is 3,600 pixels in length (12 x 300). To get the total 

we multiply the breadth by the length and the answer is 8,640,000 pixels (2400 x 3600). Well 

this is a grayscale image and we know from the section on image pixels that for a grayscale 

image each pixel is 8 bits or 1 byte in file size. So in total the A4 image of 8,640,000 pixels has 

a file size of 8,640,000 bytes or about 8.2 MB (this is because there are 1024 bytes in a kilobyte 

and 1024 kilobytes in a MB). 

http://shutha.org/node/789#how_the_numbers_work
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So it would be a whole lot easier if your editor asking you for an image big enough to fit the 

size he wants to print it at asked you for an 8 MB grayscale image. Or if he wanted it in RGB 

colour he would multiply that figure by three and ask you for a 24 MB image. 

 

Image Size Panel 

It is not necessary to calculate the file size exactly every time. Photoshop has an Image Size 

panel that can be used as a calculator. The panel cannot be accessed without an image being 

opened, so create a new image first (Ctrl+N) choosing the colour mode needed (RGB, CMYK, 

Grayscale, etc).  Make sure the 'Constrain Proportions' box is unticked to allow width and 

height to be separate, and that the 'Resample Image' box is ticked to allow the resolution to 

be separate as well. Now figures can be entered into the Document Size (highlighted) with 

the file size appearing at the top of the palette (indicated). 

 

 

FIGURE 7 The image size palette provides an accurate way of calculating the size of a digital 

image you have opened in Photoshop. 

 

FILE SIZE  

You aren't always in front of a computer when you need to calculate image size though. So it 

is really helpful to have a rule of thumb that guides you. Just think of an A4 as 24 Mb for an 

RGB colour, 8 bit image at 300dpi. The beauty of the number 24 is that it is so divisible, and 
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therefore easy to calculate file sizes. Take a piece of A4 paper and write '24 on it.  Fold it in 

half and write 12, fold again and write 6, then fold once more and write 3. Almost all the 

images you use will fit one of these sizes. So the next time you are asked what file size is need 

for a quarter page RGB photo, fold an A4 twice to give you 6 Mb.   

 

FIGURE 8 The illustration above shows a quick way of calculating the file size of an RGB image 

needed for printing an A4, A5, A6 and A7 image. 

 

A grayscale is one third of an RGB so write 8,4,2,1 instead. For a CMYK image write 32,16,8,4 

as it has one extra channel. If the image is 16 bit than double the figures. In this way, wherever 

you are you can impress your editors or clients by a speedy calculation of what file size they 

need. 

 

Image Interpolation 

If you need to have a larger file size than was provided by the digital camera or scanner, then 

Photoshop can create the extra pixels. But this does come at a cost. On the right is an image 

that was one tenth the image size of that on the left. It was then interpolated 10-fold 

(1,000 %) to bring it up to the same dimensions. While there is nothing to stop you resizing 

an image this way, be aware that Photoshop has no reference to what the original unscanned 

image looked like and therefore has to 'invent' the extra pixels. An increase of several percent 

will not be noticed, but the more the resizing, the softer the image will become. 
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FIGURE 9 The image on the left is the original quality. The one on the right was reduced to a 

10th the size and then interpolated up in Photoshop to the same size. You can see how soft 

the image becomes as Photoshop simply invents pixels and blurs all edges. 

 

File Size and Compression 

The Camera Raw file has a size, but this will be dealt with later. The Image converted from a 

Camera Raw file, or scanned from film, has a different file size. You may then crop the image 

to reduce the file size, or use interpolation to increase the file size. For the sake of simplicity, 

let us just deal with the finished image after you have shot it, converted it, and done any 

cropping. This image, when opened in Photoshop, has an "open" or "working" file size, as 

seen in the Image Size Panel section above. However, when you come to save the finished 

image you will have to decide about file compression.  Usually you will be save the image 

either as a TIFF file, which can have compression or none at all, or as a JPEG file, which will 

always have compression.  If the image has been saved with compression then you notice 

that the save image has a much smaller file size than what it was when it was open.  Think of 

this as "saved" or "compressed" file size. 

The problem comes when you look at an image that has been stored on your hard disk and 

you need to decide what the "open" or "working" file size is as it is the "open" file size that 

counts when you have to send an image to a client.  If the file is a JPEG then you know already 

that it is compressed, but if it is a TIFF then you may not know if compression was used. 
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3.6 CONCEPT OF PATH  

Understanding Paths 

When you draw an object, you create one or more lines called a path. A path is made up of 

one or more curved or straight lines, known as segments. The start and end points for a 

segment is called an anchor point. An anchor point is a bending point to modify the line 

segment. A path can be open or closed. An open path has open-ended endpoints, such as a 

line, while a closed path has connected endpoints, such as a circle. Paths can have two types 

of anchor points: smooth points or corner points. A smooth point connects two curved 

segments to create a smooth line, while a corner point connects two straight or curved 

segments to create a path direction change. You can draw a path using both smooth and 

corner points. The outline of a path is called a stroke, which you can format with different 

characteristics. You can specify stroke weight (thickness), color, or a dashed pattern. The 

interior of an open or closed path is called a fill, which you can also format with a color or 

gradient. 

 

What are Paths? 

Photoshop is not a vector-based application overall, but it does have a few vector-based 

features. The primary one is Paths. To put it simply, Paths are vector-based line drawings. A 

path is made up of any number of line segments connected by anchor points. These line 

segments can be straight, curved, or a combination of the two. For something to be a path, it 

has to be closed. This means that each anchor point has to be connected to another anchor 

point. 

 

How Do Paths Work? 

Paths have one huge advantage. Because they are vector-based, they will look just as sharp 

and clear when resized. No matter the size or resolution, you can get the same great detail 

and clarity. Another advantage to Paths is the ability to create your own unique shapes. 

Photoshop comes with a number of built-in shapes, but there are plenty more that you might 

find useful. Once you create a shape as a path that you might want to reuse in the future, you 
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can save it. This way, it’s always available as a path, so you can reuse it whenever you want 

and scale it to the size you need without any distortion or loss of quality. 

 

How Do You Use Paths? 

Paths have numerous practical applications that can make your artwork look significantly 

more professional. It’s often used by graphic designers to make text follow a curve or make a 

circle, precisely separate objects from backgrounds, and stylizing type for artistic typography, 

using Bezier Points. It’s fantastic for creating logos and other graphics that may need to be 

scaled to a number of sizes in future projects. Digital artists will also find value in the tool as 

you are able to turn freehand drawings into precise vector-based images that can be 

manipulated and scaled as desired. 

 

You can create paths in several ways: 

 With the pen tool: Draw lines with anchor points at the ends to make a path. 

 With the shapes tool: Use the Paths option to turn any shape into a path. 

 Create as a path: You can purposefully create a path using either the pen tool or the 

shapes tool. 

 Convert to a path: You can convert an existing image, graphic, or even text into a path. 

 

Just like with other elements, you are able to set a fill color for the path and both the color 

and weight for a path’s stroke. The Paths feature is probably one of the most underused and 

misunderstood features of Photoshop, but it can be an invaluable tool to add to your arsenal. 

 

Types of line segments 

There are two types of line segments: 

1. Straight line segments. These are the easiest to draw and understand. You’ll see that 

straight line segments do not have direction lines or direction points. 

2. Curved line segments. These are the tricky ones! The shape of each curve is controlled 

by the direction lines and direction points that you can see on the diagram above. More 

on these shortly. 
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Types of anchor points 

Also, there are two types of anchor points: 

1. Smooth anchor points. When the curves on each side of an anchor point enter and leave 

the point at the same angle, you have a smooth anchor point. In other words, there is 

a smooth transition through the point from one curve to the next. You can see from the 

diagram that this type of point has two direction lines opposite each other (180 degrees 

apart). 

2. Corner anchor points. This type of point marks a sharp change of directionbetween one 

curve and the next. It is also used when connected to one or two straight lines. On the 

diagram, notice that the direction lines on the corner anchor points are not 180 degrees 

apart (or in the case of the straight line segments, that there are no direction lines at 

all). 

 

About path components 

Let’s also take a quick look at path components. A path can consist of one or more path 

components. Each component is a series of segments and anchor points. Furthermore, each 

component is distinct and separate from all other components – that is, they don’t join up. 

Here’s an example of a path with 3 distinct path components: 

Note that path components don’t have to be closed paths; they can have endpoints, like the 

wavy line above. Note also that although the wavy line and triangle overlap each other, they 

are not joined, so they are still separate path components. 

3.7 PHOTOSHOP TOOLS 
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Photoshop tools for Selection, Cropping, and Measuring 

 

 

Retouching and Painting Tools 
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Drawing and Type Tools 

 

 

Navigation Tools 

 

 

3.8 PHOTOSHOP LAYERS 

Photoshop layers are like sheets of stacked acetate. You can see through transparent areas 

of a layer to the layers below. You move a layer to position the content on the layer, like 

sliding a sheet of acetate in a stack. You can also change the opacity of a layer to make content 

partially transparent. You use layers to perform tasks such as compositing multiple images, 

adding text to an image, or adding vector graphic shapes. You can apply a layer style to add a 

special effect such as a drop shadow or a glow. 

 

Organizing Photoshop layers 

A new image has a single layer. The number of additional layers, layer effects, and layer sets 

you can add to an image is limited only by your computer’s memory. 

You work with layers in the Layers panel. Layer groups help you organize and manage layers. 

You can use groups to arrange your layers in a logical order and to reduce clutter in the Layers 
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panel. You can nest groups within other groups. You can also use groups to apply attributes 

and masks to multiple layers simultaneously. 

 

Photoshop layers for non-destructive editing 

Sometimes layers don’t contain any apparent content. For example, an adjustment layer 

holds color or tonal adjustments that affect the layers below it. Rather than edit image pixels 

directly, you can edit an adjustment layer and leave the underlying pixels unchanged. A 

special type of layer, called a Smart Object, contains one or more layers of content. You can 

transform (scale, skew, or reshape) a Smart Object without directly editing image pixels. Or, 

you can edit the Smart Object as a separate image even after placing it in a Photoshop image. 

Smart Objects can also contain smart filter effects, which allow you to apply filters non-

destructively to images so that you can later tweak or remove the filter effect. 

See Nondestructive editing and Work with Smart Objects. 

 

Video layers 

You can use video layers to add video to an image. After importing a video clip into an image 

as a video layer, you can mask the layer, transform it, apply layer effects, paint on individual 

frames, or rasterize an individual frame and convert it to a standard layer. Use the Timeline 

panel to play the video within the image or to access individual frames. 

 

Photoshop Layers panel overview 

The Layers panel in Photoshop lists all layers, layer groups, and layer effects in an image. You 

can use the Layers panel to show and hide layers, create new layers, and work with groups of 

layers. You can access additional commands and options in the Layers panel menu. 

 

 

https://helpx.adobe.com/in/photoshop/using/nondestructive-editing.html
https://helpx.adobe.com/in/photoshop/using/create-smart-objects.html
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Convert background and Photoshop layers 

When you create a new image with a white background or a colored background, the 

bottommost image in the Layers panel is called Background. An image can have only one 

background layer. You cannot change the stacking order of a background layer, its blending 

mode, or its opacity. However, you can convert a background into a regular layer, and then 

change any of these attributes. When you create a new image with transparent content, the 

image does not have a background layer. The bottommost layer is not constrained like the 

background layer; you can move it anywhere in the Layers panel and change its opacity and 

blending mode. 

 

Convert a background into a Photoshop layer 
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Convert a Photoshop layer into a background 

 

 

3.9 CHANNELS IN PHOTOSHOP 

Channels are grayscale images that store different types of information: 

 Color information channels are created automatically when you open a new image. 

The image’s color mode determines the number of color channels created. For 

example, an RGB image has a channel for each color (red, green, and blue) plus a 

composite channel used for editing the image. 

 Alpha channels store selections as grayscale images. You can add alpha channels to 

create and store masks, which let you manipulate or protect parts of an image. 

 Spot color channels specify additional plates for printing with spot color inks. 

 

 An image can have up to 56 channels. All new channels have the same dimensions and 

number of pixels as the original image. 

 

The file size required for a channel depends on the pixel information in the channel. Certain 

file formats, including TIFF and Photoshop formats, compress channel information and can 

save space. The size of an uncompressed file, including alpha channels and layers, appears as 
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the right-most value in the status bar at the bottom of the window when you choose 

Document Sizes from the pop-up menu. 

 

3.10 FILTERS IN PHOTOSHOP 

It can use filters to clean up or retouch your photos, apply special art effects that give your 

image the appearance of a sketch or impressionistic painting, or create unique 

transformations using distortions and lighting effects. The filters provided by Adobe appear 

in the Filter menu. Some filters provided by third-party developers are available as plug-ins. 

Once installed, these plug-in filters appear at the bottom of the Filter menu. 

Smart Filters, applied to Smart Objects, let you use filters non-destructively. Smart Filters are 

stored as layer effects in the Layers panel and can be readjusted at any time, working from 

the original image data contained in the Smart Object. To use a filter, choose the appropriate 

submenu command from the Filter menu. These guidelines can help you in choosing filters: 

 

 Filters are applied to the active, visible layer or a selection. 

 For 8-bits per-channel images, most filters can be applied cumulatively through the 

Filter Gallery. All filters can be applied individually. 

 Filters cannot be applied to Bitmap-mode or indexed-color images. 

 Some filters work only on RGB images. 

 All filters can be applied to 8-bit images. 

 The following filters can be applied to 16-bit images: Liquify, Vanishing Point, 

Average Blur, Blur, Blur More, Box Blur, Gaussian Blur, Lens Blur, Motion Blur, Radial 

Blur, Surface Blur, Shape Blur, Lens Correction, Add Noise, Despeckle, 

Dust & Scratches, Median, Reduce Noise, Fibers, Clouds, Difference Clouds, Lens 

Flare, Sharpen, Sharpen Edges, Sharpen More, Smart Sharpen, Unsharp Mask, 

Emboss, Find Edges, Solarize, De-Interlace, NTSC Colors, Custom, High Pass, 

Maximum, Minimum, and Offset. 

 The following filters can be applied to 32-bit images: Average Blur, Box Blur, Gaussian 

Blur, Motion Blur, Radial Blur, Shape Blur, Surface Blur, Add Noise, Clouds, Lens Flare, 

Smart Sharpen, Unsharp Mask, De-Interlace, NTSC Colors, Emboss, High Pass, 

Maximum, Minimum, and Offset. 
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 Some filters are processed entirely in RAM. If you don’t have enough available RAM 

to process a filter effect, you may get an error message. 

 

3.11 RENDERING IN PHOTOSHOP 

In the world of graphics and architecture, a rendering is the term used for a two-dimensional 

drawing that an artist creates to illustrate what a structure will look like once it has been built. 

From this term came the word render, which means "to make visible" or "to draw." With the 

advent of the digital age and the introduction of computer-aided design software like 

Photoshop, these terms have evolved to match the evolution of the tools available 

 

Rendering 

Rendering in Photoshop deals specifically with the process of taking a two-dimensional image 

of a three-dimensional subject and making the final image look as realistic as possible. This 

goal is achieved through the use of various lighting and shadowing effects, as well as the 

generation of environmentally appropriate light refraction and reflection. The use of any of 

these techniques is referred to as rendering. The term also applies to the process of adding 

texture to a surface within the image. 

 

Render Filters 

Render filters are one of several categories of filter available for use in the Photoshop 

program. Filters are used both to perform editing tasks such as blurring or dimming images 

and to apply special effects like textures and distortions. Render filters create effects that deal 

specifically with light refraction and reflection, cloud and shadow generation and the 

application of fiber textures. Other filter types include blur filters, brush stroke filters, noise 

filters, pixelate filters and sketch filters. 

 

Rendering Uses 

The rendering process in Photoshop has many potential uses in the graphics-editing world. It 

can be used to create the illusion of a variety of fabrics such as satin or cotton fiber. It can 

also be used to change the time of day suggested by an image by adjusting the amount and 



International Institute of Technology and Management, Murthal 
BCA 2ND – Desktop Publishing (DP) – BCA 108-B 

 

53 
 

intensity of the lighting. It can generate realistic shadows and highlights in a flat image to 

create the impression of three dimensions. 

 

3.12 TRANSFORMATION OF OBJECTS IN ADOBE PHOTOSHOP 

After an object is inserted in a new layer, we can use Layer transformation commands to 

transform the object. To transform the layer or the selected fragment we can use one of the 

commands from the menu Edit - Transform. For example, the following commands: Scale, 

Rotate, Skew, Distort, Perspective, Rotate 180°, Rotate 90° CW, Rotate 90° CCW, Flip 

Horizontal, Flip Vertical. You can also use the command Free Transform from the Edit menu, 

which will help you to perform all transformations at one time. If you select the command 

Edit – Free Transform, the layer or the selected fragment will be enclosed in a frame with 

eight markers, and in the Options palette a number of parameters for adjustment will appear 

 

Scale – to adjust the scale of the image within the area you should move one of the eight 

markers. To change the scale proportionally you should drag the marker in the corner keeping 

the Shift  key pressed. You can enter values for the W and H parameters in percentage from 

the original size directly in the Options palette. For the size to be changed proportionally, you 

should activate the relation sign between the W and H parameters. 

 

Flip – to flip an image you should move one of the markers behind the opposite marker. For 

example, if you drag the left marker all the way to the right side of the right marker, the image 

will flip horizontally. However, if all you want is to flip the image, you'd better use the 

commands Flip Horizontal and Flip Vertical from the menu Edit – Transform. 

 

Rotate – to rotate an image you should bring the cursor to the marker in the corner so that 

the cursor transforms in a two-side rounded arrow, press the left mouse and keeping it 

pressed, drag the cursor. You can set the rotation angle in the Options palette using the 

Rotate parameter. 
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Skew – to skew an image you should drag the marker on the side, the upper and the lower 

marker keeping the Ctrl  key pressed ( Command  in Mac). You can adjust the Skew 

transformation option in the Options palette setting the H and V parameters. 

 

Distort – it is possible to distort an image by dragging a corner marker keeping the Ctrl  key 

pressed ( Cmd  in Mac). 

 

Perspective – to create a perspective you should drag a corner marker keeping 

the Ctrl  and Shift  keys pressed ( Cmd  and Shift  in Mac). 

 

3.13 STROKE A SELECTION IN PHOTOSHOP  

Stroking in Photoshop CS6 enables you to create outlines of selections, layers, or paths. 

Stroking a selection creates a border around the selection. It’s up to you to decide whether 

to put the border inside, outside, or centered on the selection. (Photoshop doesn’t care.) 

To stroke a selection, follow these steps: 

 

1. In the Tools or Colors panel, choose a foreground color and make a selection of your 

choice. 

2. Choose Edit→ Stroke. 

3. In the Stroke dialog box, adjust the settings and the options. 

a. Width: You can select 1 to 250 pixels. You can also type a value by using 

another measurement, such as inches, but Photoshop converts it to pixel 

values before applying. 

b. Color: Click in the Color box to select the hue you want from the Color Picker. 

c. Location: Select where Photoshop should apply the stroke in relation to your 

selection border. The Inside option always gives you sharp corners on a 

rectangle. The Center and Outside options can result in blunt, mitered corners. 

d. Mode: This determines how the stroke color merges with other colors on the 

same layer. 
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e. Opacity: The default value is 100%. If you want the stroke to be semi-

transparent, type another value. 

f. Preserve Transparency: Select this option to apply the stroke only to no 

transparent pixels. 

4. Click OK to apply the stroke. 

 

3.14 ACQUIRING & IMPORTING IMAGES 

Acquiring Images 

There are several ways you can go about getting images into Photoshop: 

 Create an image from scratch by choosing File>New in Photoshop 

 Open an image file that already exists on your computer by choosing File>Open. 

 Download an image from a website to your computer. You can usually do this by right-

clicking on the image in your browser and choosing "Save Image As..."  However, you 

need to be aware of copyright restrictions on any images you may which to use.  

 Acquire an image from a digital camera either by downloading it with a cable or by 

using a media card reader.  To use a media card reader, remove the media card from 

the camera, insert the card into the card reader, and plug the card reader cable into 

the computer (typically into a USB or firewire port).  You can then drag the image files 

to the computer desktop. 

 Scan an image using a slide scanner (for negatives or slides) or flatbed scanner (for 

prints). 

 

Importing Images into Photoshop 

When you acquire images in Photoshop Elements from media sources, such as CD-ROMs, 

DVDs, external hard drives, and your internal hard drive, the process is very similar to opening 

files from digital cameras. Insert a CD or DVD into the CD/DVD drive, and the Windows 

AutoPlay Wizard opens just like when you insert a media cartridge or connect a cable from 

your camera to your computer. 

 

Getting files from storage media 

Just cancel out of the wizard if a wizard launches and follow these steps: 
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1. Open the Organizer from the Welcome screen. 

2. When the Organizer window opens, choose File→ Get Photos and Videos→ From 

Files and Folders. 

3. Open the source drive from the listed drives. 

4. Select images and click Get Media (from the Organizer) or Open (from one of the 

editing modes) to open the files in the Organizer or an editor. 

 

3.15 IMAGE MODES 

An image mode determines the number of colors that can be displayed in an image and can 

also affect the file size of the image. Photoshop Elements provides four image modes: RGB, 

bitmap, grayscale, and indexed color. 

 

Bitmap mode 

Uses one of two color values (black or white) to represent the pixels in an image. Images in 

bitmap mode are called 1-bit images because they have a bit depth of 1. 

 

Grayscale mode 

Uses up to 256 shades of gray. Grayscale images are 8-bit images. Every pixel in a grayscale 

image has a brightness value ranging from 0 (black) to 255 (white). Grayscale values can also 

be measured as percentages of black ink coverage (0% is equal to white, 100% to black). 

 

Indexed Color mode 

Uses up to 256 colors. Indexed-color images are 8-bit images. When converting into indexed 

color, Photoshop Elements builds a color lookup table (CLUT), which stores and indexes the 

colors in the image. If a color in the original image does not appear in the table, the program 

chooses the closest one or simulates the color using available colors. By limiting the panel of 

colors, indexed color can reduce file size while maintaining visual quality—for example, for a 

web page. Limited editing is available in this mode. For extensive editing, you should convert 

temporarily into RGB mode. When you choose a different color mode for an image in the Edit 

workspace (Image > Mode > [image mode]), you permanently change the color values in the 

image. You might want to convert into a different mode for several reasons. For example, you 
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may have an old scanned photo in grayscale mode in which you want to add color, so you 

would need to convert it into RGB mode. Before converting images, it’s best to do the 

following: 

 Edit as much as possible in RGB mode. 

 Save a backup copy before converting. Be sure to save a copy of your image that 

includes all layers in order to edit the original version of the image after the 

conversion. 

 Flatten the file before converting it. The interaction of colors between layer 

blending modes will change when the mode changes. 

 

RGB Color mode 

 The default mode of new Photoshop Elements images and images from your digital 

camera. In RGB mode, the red, green, and blue components are each assigned an 

intensity value for every pixel—ranging from 0 (black) to 255 (white). For example, a 

bright red color might have an R value of 246, a G value of 20, and a B value of 50. 

When the values of all three components are equal, the result is a shade of neutral 

gray. When the value of all components is 255, the result is pure white; when the value 

is 0, the result is pure black. 

 

3.16 CANVAS AND IMAGE SIZE IN PHOTOSHOP 

When working with an image-editing program, such as Adobe Photoshop, you can modify 

both the image size and canvas size of an image. While they sound similar, they modify the 

image in two different ways. When you modify the canvas size of an image, you either 

increase or decrease the amount of area of the image canvas. This means that adding to the 

canvas size will add blank area around the image (or fill it with the background color if there 

is only one layer). Conversely, if you decrease the canvas size, the image will be cropped, 

meaning you will lose some of the image depending on where you crop it. 

When you modify the image size of an image, you change how large the image is. 

When you increase the image size, the image will appear bigger, and may become blocky or 

blurry if increased too much. Decreasing the image size will shrink the image, and may cause 

some detail to be lost. When you change the image size, you can also modify the image 



International Institute of Technology and Management, Murthal 
BCA 2ND – Desktop Publishing (DP) – BCA 108-B 

 

58 
 

resolution (in DPI), and stretch the image by unchecking the "Constrain Proportions" box. 

Unlike changing the canvas size, when you change the image size, the original image still fills 

the whole window. 

So if you want to add more area to an image or crop a section of it, change the canvas size. If 

you want to shrink, expand, or change the resolution of an image, adjust the image size. 

 

 

UNIT – 4 (QUESTION BANK) 

35 Explain about Corel Draw. 

36 What are the Menus in Corel draw? 

37 What are the Tools in Corel draw? 

38 Explain ruler bar. 

39 What is vector graphics? 

40 Explain Color palette. 

41 Explain Transformations in Corel Draw. 

42 Explain Weld Objects in CorelDraw. 

43 Explain Intersection of Objects in Corel draw. 

44 What is snapping objects?  

45 Explain the special effects in Corel draw. 

 

UNIT – 4 (NOTES) 

Overview of Corel Draw: 

Coral draw is one of the most important applications used in designing through which you can 

design any type of picture, logo or monogram. This vector-based drawing program can be 

used to create an advertisement for any company, birthday cards, logos, Boucher and 

newspaper to World Wide Web Pages. CorelDraw offers a complete set of tools for creating 

much kind of drawings and multi page documents.  

https://pc.net/glossary/definition/dpi


International Institute of Technology and Management, Murthal 
BCA 2ND – Desktop Publishing (DP) – BCA 108-B 

 

59 
 

CorelDraw tools are designed to meet the demands of the graphic arts professional. 

Each of the tools used in CorelDraw has one special work associated with it. With these tools 

we can type and zoom the text, draw objects, fill circles and lines with colors and do many 

more things. If you are new to CorelDraw, the program may seem complex at first because it 

is so rich in features, but if you take it one step at a time you’ll soon be creating impressive 

drawings. 

 

The CorelDraw Interface 

A program’s interface refers to the way it looks and to the controls, dialog boxes and other 

components that enables you to interact with it. When you launch CorelDraw, the application 

window opens containing a drawing window. The rectangle in the center of the drawing 

window is the drawing page where you create your drawing. Although more than one drawing 

window can be opened, you can apply commands to the active drawing window only. 

 

Menu in Corel Draw 

File edit view layout arrange effects bitmaps text tools window help. 

 

File 

NEW Creates a “ New Blank document“  

 

NEW FROM TEMPLATE  

Creates a new document by using existing designed formats.  

 

OPEN  

Opens an existing or saved document  

 

CLOSE  

Close the active document without exiting the program. 

 

SAVE  

Saves the active file with its current file name, location and file format  
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SAVE AS  

Saves an already saved file with different name and Format.  

 

REVERT  

Revert to the last saved version of a drawing  

 

ACQUIRE IMAGE  

Lets you scan something using the installed scanner. 

 

IMPORT  

Lets you import a bitmap or any other file into a document either directly or by linking it to 

an external file. When you link to an external file, edits to the original file are automatically 

updated in the imported file.  

 

EXPORT  

Lets you export and save images to a selected file format that can be used in other 

applications. For example, you can export a file to the Adobe Illustrator (AI) or GIF format.  

 

SEND TO  

Sends your active documents directly to various locations like My Documents, Mail Recipient, 

Creates shortcut for your file on desktop etc.  

 

PRINT  

Prints active document  

 

PRINT MERGE  

You can use the Print merge wizard to combine text with a drawing. 

 

PRINT PREVIEW  

Shows how a document will look when you print it.  
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PRINT SETUP  

Lets you change the print settings.  

 

PREPARE FOR SERVICE BUREAU  

You can use the Prepare for service bureau wizard to guide you through the process of 

sending a file to a service bureau. The wizard simplifies processes such as creating PostScript 

and PDF files; gathering different pieces required for outputting an image; and copying the 

original image, embedded image files, and fonts to a user-defined location.  

 

PUBLISH TO WEB  

It provides several options for publishing your document or selection for use on the World 

Wide Web. You can choose several options such as image format, HTML layout, export range, 

and file transfer protocol (FTP) site parameters for uploading your files.  

 

PUBLISH TO PDF  

Lets you export or save your file in a PDF file format. The Portable Document Format (PDF) is 

a file format designed to preserve fonts, images, graphics, and formatting of an original 

application file. Using Adobe Acrobat Reader and Adobe Acrobat Exchange, a PDF file can be 

viewed, shared, and printed  

 

DOCUMENT INFO  

Gives you detailed information about your active document. 

 

EXIT  

To close the active document and exit the Corel draw. 

 

Tools in Corel draw 

he various tools available in the toolbox are explained below in Table 1.2. 
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Using the rulers 

You can display rulers in the drawing window to help you draw, size, and 

align objects precisely. You can hide the rulers or move them to another position in the 

drawing window. You can also customize the ruler settings to suit your needs. For example, 

you can set the ruler origin, choose a unit of measure, and specify how many marks or ticks 

appear within each full unit mark. By default, CorelDRAW applies the units used for the rulers 

to the duplicate and nudge distances. You can change the default and specify different units 

for these and other settings. For information about nudging, see Positioning objects. 

 

To hide or display the rulers 
 

•   Click View  Rulers. 

 A check mark beside the Rulers command indicates that the rulers are displayed. 

  

javascript:WWHClickedPopup('CorelDRAW_Help',%20'CorelDRAW-Glossary.html#wp1374897');
javascript:WWHClickedPopup('CorelDRAW_Help',%20'CorelDRAW-Glossary.html#wp1687370');
javascript:WWHClickedPopup('CorelDRAW_Help',%20'CorelDRAW-Glossary.html#wp1304163');
http://product.corel.com/help/CorelDRAW/540240626/Main/EN/Doc/CorelDRAW-Positioning-objects.html#wp1314379
javascript:WWHClickedPopup('CorelDRAW_Help',%20'CorelDRAW-Glossary.html#wp1374897');
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To move a ruler 

•   Hold down Shift, and drag a ruler to a new position in the drawing window. 

 

To customize ruler settings 
 

1.   Click View  Setup  Grid and ruler setup. 

2.   In the Document list of categories, click Rulers. 

3.   In the Units area, choose a unit of measure from the Horizontal list box. 

 If you want to use a different unit of measure for the vertical ruler, disable the Same units 

for horizontal and vertical rulers check box, and choose a unit of measure from 

the Vertical list box. 

4.   In the Origin area, type values in the following boxes: 

 •  Horizontal 

 •  Vertical 

5.   Type a value in the Tick divisions box. 

 

Vector Graphics 

Vector graphics is the creation of digital images through a sequence of commands or 

mathematical statements that place lines and shapes in a given two-dimensional or three-

dimensional space. In physics, a vector is a representation of both a quantity and a direction 

at the same time. In vector graphics, the file that results from a graphic artist's work is created 

and saved as a sequence of vector statements. For example, instead of containing a bit in the 

file for each bit of a line drawing, a vector graphic file describes a series of points to be 

connected. One result is a much smaller file. At some point, a vector image is converted into 

a raster graphics image, which maps bits directly to a display space (and is sometimes called 

a bitmap). The vector image can be converted to a raster image file prior to its display so that 

it can be ported between systems. 

A vector file is sometimes called a geometric file. Most images created with tools such 

as Adobe Illustrator and CorelDraw are in the form of vector image files. Vector image files 

are easier to modify than raster image files (which can, however, sometimes be reconverted 

to vector files for further refinement). 

javascript:WWHClickedPopup('CorelDRAW_Help',%20'CorelDRAW-Glossary.html#wp1374897');
javascript:WWHClickedPopup('CorelDRAW_Help',%20'CorelDRAW-Glossary.html#wp1374897');
https://whatis.techtarget.com/definition/raster-graphics
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Animation images are also usually created as vector files. For example, 

Shockwave's Flash product lets you create 2-D and 3-D animations that are sent to a requestor 

as a vector file and then rasterized "on the fly" as they arrive. 

 

Color Palette 

A color palette is a set of colors in a group meant to be used for a certain kind of output. You 

use them to apply FILL and OUTLINE colors to text and objects. The primary color groups or 

models are RGB, CMYK and SPOT color. Some common uses for these color models are: 

 

 CMYK colors are for offset 

 RGB are for web graphics, digital printing, sublimation and laser engraving 

 SPOT colors for screen printing, vinyl cutting and some other printing methods. Some 

colors cannot be printed in CMYK so a SPOT COLOR will be used to acquire an exact 

color match. 

 

Each kind of color has specific values or name. This blue color all looks the same but there are 

actually 3 different color models. 

 

Palette Options 

At the top or left end of all palettes (depending on if the palette is docked horizontally or 

vertically) is a small black arrow (flyout button) to open the palette options. 

https://whatis.techtarget.com/definition/Flash
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You can set a palette as the default palette, choose to show color names on the swatches, or 

have the palette displayed in 1, 2 or 3 rows. And if you click on Customize in the flyout menu, 

you have further palette options available such as large swatches and wide borders. 

 

The Document Palette 

The Document palette contains the colors used in your current document and appears in the 

bottom left corner of the interface, above the status bar. Every time you use a color in your 

document it’s automatically added to the Document palette – even if you later change the 

color or remove it from your document. If you have removed colors from your Document 

palette, or added a bitmap, you can choose to reset your color palette. Click on the flyout 

arrow and select Palette > Reset Palette. This will then give the opportunity to add colors from 

a bitmap. However, if you prefer to control which colors are added to the Document palette, 

you can disable the automatic updates and add colors manually by dragging colors from your 

document down into the palette. To disable automatic updates, click on the flyout arrow and 

select Customize. Uncheck the setting Automatically update the document palette. 

 

The Document palette is open by default but if you don’t see it, go to Window > Color 

Palette > Document Palette to open it. 
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The Document palette is saved with the document so that if you take the file to a different 

system, you will have it there as well. 

 

Transformations in Corel Draw: 

Use the Transformations ducker in CorelDRAW to position, rotate, scale, mirror, and skew 

objects with ease and precision. You can transform selected objects, and you can transform 

copies of the selected objects, leaving the original objects unchanged. 

 

1. Select the object. 

2. Click Object menu > Transformations, and click a command. 

The Transformations docker opens at the page that corresponds to the command you 

selected (the Rotate page in the following example). 
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3. Do any of the following: 

 Type the values you want, and click Apply. The selected object is transformed. 

 To apply the transformation to an object’s copy leaving the original object untouched, 

hold down Shift, and click Apply. 

 To apply the transformation to multiple object copies, type a number in 

the Copies box, and click Apply. 
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Weld Objects in CorelDraw 

Welding objects together in CorelDraw creates one object with a single line. In this example, 

three separate shapes were joined to make one shape. Follow these three steps to weld 

objects: 

 

1. Select all the objects by holding down the shift key and clicking on each shape. You 

can also just drag the selection tool over all the objects. (Image 1) 

2. Click Arrange > Shaping > Weld (Image 2) or use the Weld button located in the 

property bar. (Image 3) 

3. The new object will take on the fill and outline properties of the “target” object. The 

“target” object is the first object you created or the last of all the objects you select 

by holding down the shift key and clicking on each object. 

 

Intersection of Objects: 

1 . Select the source object. 

2 . Hold down Shift, and select the target object. 

3 . Click Object  Shaping  Intersect. 

 In the Classic workspace, this command appears under the Arrange menu. 

 

To intersect multiple objects 

1 . Marquee select the source object or objects. 

2 . Hold down Shift, and click each target object. 

3 . Click Object  Shaping  Intersect 

 

Snapping objects 

When you move or draw an object, you can snap it to another object in a drawing. You can 

snap an object to various snap points on the target object. When you move the pointer close 

to a snap point, the snap point becomes highlighted, which identifies it as the pointer’s 

snapping target. You can snap objects to other objects, to page elements (such as the center 

of the page), to the document grid, pixel grid, baseline grid, or the guidelines. 

javascript:WWHClickedPopup('CorelDRAW',%20'CorelDRAW-Glossary.html#1882786', 'popups/u002Fglossary_drptdes-1882786.html');
javascript:WWHClickedPopup('CorelDRAW',%20'CorelDRAW-Glossary.html#1882786', 'popups/u002Fglossary_drptdes-1882786.html');


International Institute of Technology and Management, Murthal 
BCA 2ND – Desktop Publishing (DP) – BCA 108-B 

 

69 
 

To snap an object to another object with greater precision, you can first snap the 

pointer to a snap point in the object, and then snap the object to a snap point in the target 

object. For example, you can snap the pointer to the center of a rectangle, drag the rectangle 

by the center, and then snap the rectangle to the center of another rectangle. 

 

 

 

 

Giving Effects in Corel Draw: 

Transform an average design into an amazing design with a variety of special effects tools in 

CorelDraw Graphics Suite. With a versatile toolbox at your fingertips, you can decide how 

subtle or how grand your special effects will be for each design project. CorelDRAW is proud 

to feature four pressure-sensitive Liquid tools—Smear, Attract, Repel and Twirl—that give 

you the creative edge for retouching photos. 

Apply several camera effects to adjust the color and tone of your photos, including 

Bokeh blur, Colorize, Sepia toning and Time Machine. These visually stunning special effects 

allow you to recreate popular photographic styles from the past with seven unique visual and 

historic styles that range from 1839 to the 1960s. Enjoy even more ways to enrich your images 

with RAW file support for over 300 types of cameras. Your design combinations are endless 

with this diverse collection of special effects. Here are some additional special effects can 

easily incorporate into your everyday drawings: 
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 Shape tools 

 Freehand Pick tool 

 Quick Pan tool 

 Drop Shadow tool 

 

What can these special effects tools do for you? 

 

Shape tools 

Reap the benefits from four new shaping tools that provide creative special effects options 

for refining your vector objects, including the Smear tool, Twirl tool and the Attract and Repel 

tools. 

 

Freehand Pick tool 

Save time by gaining greater control over object selection and transformation, especially 

when working with curved objects and non-linear shapes. See how the Freehand Pick tools 

allow you to easily isolate and manipulate an object. A very popular special effects tool! 

 

Quick Pan tool 

With a single click, you can bring out the pan hand to quickly pan around your image while 

maintaining your same zoom level. It’s a brilliant way to get a visual overview of your entire 

project. 

 

Drop Shadow tool 

Learn how to create a chiseled wood carving special effect with the Drop Shadow tool. Watch 

how easy it is to apply a cool chiseled effect to your text. 


